
Private Wells 
in New Jersey: 
Building 
Local Health 
Capacity

Presenters:

Jessie Gleason, MSPH

New Jersey Department of Health

Rebecca Schwartz

New Jersey Department of Health 

1



Presentation Agenda

• Needs Assessment Findings

• Private Well Water Regulations in NJ 

• Specific Contaminants of Concern
• Coliform

• Gross Alpha

• Arsenic

• Water Treatment Financing Programs

• Public Notification: Neighbors Outreach

• Identification of Neighbors: Tips & Tools

2



Centers for Disease Control and 
Prevention (CDC) Support

• Perform targeted outreach efforts: neighbor-based, 

school-based, communities & healthcare-based

• Develop guidance that can be utilized by local health 

departments

• Provide local health department funding

• $5,000 awards to support private well outreach

• NJ SAGE

• Estimated funding opportunity announcement 

October/November Up to three LHD awards available 

over the next four years (dependent on funding 

availability)
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Private Wells in New Jersey 

• Most densely populated state in 
U.S.

• About 11-13% of NJ residents on 
private well water, about 1 million 
people

• Estimated 400,000 wells used for 
water consumption purposes

• No federal regulations - unregulated 
under 1974 Safe Drinking Water Act
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Needs Assessment Findings
• Limited survey to LHD attendees at 2016 NJ NEHA meeting

• Included representatives from 11 LHDs that serve private 
well users

• Staffing shortages and heavy workloads identified as 
barriers to LHD private well programs 

• Respondents were asked whether they conduct outreach 
when the PWTA identified a problem

• 50% responded ‘Yes’

• 50% responded ‘No’

Do you think your 

health department 

does a good job 

assisting private well 

users?

VERY 
GOOD

42%

GOOD
25%

FAIR
25%

POOR
0%

VERY 
POOR

8%
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Needs Assessment Findings: 
LHD Training for Private Wells
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Needs Assessment Findings: 
Contaminants of Concern

What are the most important private well contaminants of 
concern in your service area?
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Percentage of Most Prevalent Contaminants 

Exceeding MCLs in Private Wells
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9

How frequently do you receive questions from 
private well users?

ⓘ Start presenting to display the poll results on this slide.



Private Well Water Regulations in NJ 
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NJ Private Well Testing Act 
(NJ PWTA)

• Adopted September 2002

• Consumer Information law

• Requires buyer or seller of property with a private well to test 
untreated water 

• Landlords required to test wells every 5 years

• Confidential

• Certified laboratories submit water results electronically to NJDEP

• Some water quality parameter requirements are specific 
to geographic location (North v. South Jersey)

• ~100,000 (25%) wells test results reported

https://www.state.nj.us/dep/watersupply/pw_pwta.html
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Private Well Testing Act Rules

• Sample collection and analysis must be performed by a PWTA 
certified lab 

• List of labs available at NJDEP Data Miner 
https://www13.state.nj.us/DataMiner

• Laboratory must follow reporting rules using standard form 
and must report to NJDEP electronically

• Analytical results are valid for 1 year

• Coliform results valid for 6 months

• Raw water samples (pressure tank or bypass treatment and 
sample at kitchen sink)

• Lead sampling requires 2-minute flush

• Laboratory must notify person requesting the test and local 
health department of a violation within 24 hours from obtaining 
results

• NJDEP shall notify LHD of violation within 5 business days after 
receiving notice 12
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PWTA Required Parameters

Primary Drinking Water 

Contaminants MCL

Bacteriological:

Total Coliform (E. Coli or 

Fecal)

Presence/

Absence

29 Volatile Organic 

Compounds (VOCs)

MCLs 

vary  

Inorganic Compounds:

Arsenic

Lead

Mercury

Nitrates

5 µg/L

5 µg/L

2 µg/L

10 mg/L

Radiological:

Gross Alpha

Uranium*

Radium (226+228)

15 pCi/L

30 µg/L

5 pCi/L

Secondary Drinking 

Water Contaminants SMCL

pH 6.5-8.5

Iron 0.3 mg/L

Manganese 0.05 mg/L

Abbreviations

MCL = Maximum Contaminant Level

SMCL = Secondary Maximum 

Contaminant Level

ml = milliliters

pCi/L = picocuries per liter

µg/L = micrograms per liter



NJ PWTA Expansion Includes PFAS

• NJ MCLs developed for PFNA, 
PFOA and PFOS 

• Testing for PFAS required 
under NJ PWTA - December 
2021

PFAS MCL

PFNA 13 ppt

PFOA 14 ppt

PFOS 13 ppt

parts per trillion (ppt) = Nanogram/Liter (ng/L) 

https://www.nj.gov/health/ceohs/docu
ments/pfas_drinking%20water.pdf
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Frequently Asked Questions (FAQs)
How much will the testing cost? 

• Currently, $650 - $750.

• With PFAS included, around $1,000

What is the cost of water treatment?

• It depends on contaminant. Potable water loan available (0% 
interest)

How do I know what water treatment is suitable? 

• Contact a local water treatment consultant if you are 
unsure about appropriate water treatment. Water treatment 
professional are not certified.

Is the water safe to bathe/shower in? 

• It depends (arsenic and VOCs above MCL not recommended for 
bathing/showering).

Does boiling/cooking water get rid of the contaminants? 

• No – can cause contaminants to concentrate even more.

https://www.state.nj.us/dep/watersupply/pwta/pwta_faq.htm 15
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NJ PWTA Data Summary

https://njdep.maps.arcgis.com/apps/MapSeries/index.html

?appid=826ec9fae77543caa582a787d5f088e7

• Data summarized by county, municipality and 2x2 mile grids

• Address location feature allows pinpoint to grid
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Legend
% of Wells Exceeding MCL 

( > 15 pCi/L)

Less than 10 wells 
sampled

No wells

0 – 15 %

15 – 30 %

30 – 45 %

45 – 60 %

60 – 76.8 %

Gross Alpha Data: 

PWTA (2002 – 2018) 
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Legend
% of Wells Exceeding MCL 

( > 5 µg/L)

Less than 10 wells 
sampled

No wells

0 – 15 %

15 – 30 %

30 – 45 %

45 – 60 %

60 – 76.8 %

Arsenic Data: 

PWTA (2002 – 2018)
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NJ Safe Drinking Water Act
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• New wells: requires conditional “certification” from LHD before 
drilling begins (or alteration)

• Upon completion of new well – the owner must have a state-
certified laboratory test the water for contaminants and submit 
results to local health agency

• Local health agency may require “physical and chemical 
treatment”

• Local health agency shall require treatment when

• (1) water does not meet the primary drinking water standards
• (2)water exceeds the secondary drinking water standard

• Local health agency finalizes certification after well is 
constructed and tested.

• Pursuant to SDWA, New Jersey Housing and Mortgage 
Finance Agency provides 0% loans for treatment



New Jersey Subsurface and Percolating 
Waters Act

• Only professionals licensed by DEP and the State Well Drillers 
and Pump Installers Examining Board are authorized in installing, 
servicing, repairing and decommissioning residential wells and 
pumping equipment

• Well drillers are specifically authorized to install, maintain, and 
replace treatment equipment located between a well and 
storage tank

• A master well driller has authority to certify that a well –
including any related treatment –

has been constructed in accordance with state standards

• Establishes construction standards for wells, and minimum 
distance requirements from buildings, sewers, septic tanks, and 
fuel storage tanks, among other things 



Water Treatment Regulations

• There are no regulations for treatment professionals, only 
regulations regarding treatment installation are in the 
plumbing code

• State plumbing license law of 1968

• “Master plumber” requires valid license 

• Plumbing license is required to install or disconnect 
“water filtration or softening equipment” 
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Local Ordinances

• Hopewell Twp., Mercer County 
• Requires two-tank arsenic treatment if PWTA results exceed NJ 

arsenic MCL

• Cumberland County Health Department
• Ordinance #12

• Requires water certification before Certificate of Occupancy can be 
issued and for rental licenses

• Original lab results (initial and/or retest) presented to CCHD - all PWTA 
required parameters must pass standards

• Certificate issued for a fee paid to CCHD

Extra credit for information on other local ordinances

(add to chatbox or send me an email)
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Specific Contaminants of Concern

23



Private Well Sources of Contamination

Naturally occurring sources:

• Private wells drilled into bedrock units

• Underlying bedrock geology (e.g. - arsenic, gross alpha, uranium, 
radium)

• Leaches into water through – construction of new well, 
drilling, and/or fractured bedrock units

• Other contributing factors: age, depth, and type of well

Anthropogenic sources:

• Agricultural and lawncare – nitrates

• Septic tanks – microorganisms

• Minimum of 100-foot separation of leach fields and septic tanks from 
well

• Air pollution

• Industrial discharge
24



Coliform Bacteria

• Required PWTA testing statewide in NJ
• Results are good for 6-months if using for PWTA

• Total coliform (TC) - "indicators" for possible disease-causing 
microorganisms

• Sources: septic tanks, contaminated surface waters, stormwater 
runoff, damage to well head such as a broken well cap, etc.

• Colilert – simultaneously determines presence of coliform and 
E.Coli – no confirmation test needed

• Test annually

• Water treatment: Ultraviolet light or chlorination

• Additional Resources – Penn State Extension:

• https://extension.psu.edu/coliform-bacteria

• https://extension.psu.edu/shock-chlorination-of-wells-and-springs
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TC/EC Recommendations:

• If (TC + / EC +) stop drinking water

• If (TC +/ EC -) or (TC +/ EC +) the following steps may be useful:

1. Retest immediately (ASAP, < 1 week); test again in 6 months

2. Ongoing (+) test results require removal of surface contamination source(s), 
remedy of well construction defects (Does rainfall surface runoff impact the 
wellhead area? Is there a septic tank leach field near by with potential 
impact? Are there pet and/or farm animal wastes near the wellhead?) 

3. If unable to find an issue, have well inspected by certified well professional

4. If still unable to find an issue, install certified UV disinfection system or install 
a new well

5. Shock chlorination may be appropriate if the source of your contamination is 
nearby and likely due to a one-time event (e.g., a neighbor drilled into the 
same aquifer and you’re downstream, hurricane and extreme flooding or 
maintenance on a well that could have introduced bacteria)

6. After two weeks retest to ensure corrective actions have remedied the issue
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Gross Alpha 
Background Information

• Gross alpha is a measurement 

of radioactivity in drinking water

• MCL: 15 pCi/L

• Naturally occurring

• North vs. South Jersey

• North – Uranium, lesser extent radium

• South – Radium

• Odorless, colorless, tasteless

• Adverse health effects

• Radium – bone and sinus cancer

• Uranium – kidney toxicity

• Requires a 48-hour test

Legend

15–30 pCi/L

> 30 pCi/L

PWTA (2003 – 2014) Gross 
Alpha Exceedances
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• Radioactivity (i.e., gross alpha) in drinking water is caused 

by elements such as radium and uranium

• Radium: MCL of 5 pCi/L

• If gross alpha > 5 pCi/L but < 15 pCi/L additional testing 

for combined isotopes radium-226 (Ra-226) + radium-228 

(Ra-228) recommended

• 48-hour gross alpha test captures Ra-224 (half-life < 4 
days)

• Uranium: MCL of 30 µg/L or ppb

• Naturally occurring isotopes: uranium-234 (U-234) and/or 
uranium-238 (U-238)

Radioactive Elements and 

Isotopes
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Gross Alpha Water Treatment Options

• Water softener

• $1200 - $1500

• POU Reverse Osmosis

• $800

Radium (Positive Charge +)

• Anion Exchange (followed by pH 
neutralizer)

• $2000

• POU Reverse Osmosis

• $800

Uranium (Negative Charge -)
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Radioactivity in Drinking Water Guides

• How and why 

radioactivity affects 

private wells

• Risks of 

radioactivity

• Testing procedures

• Ways to reduce 

radioactivity 

North Jersey Guide: https://www.state.nj.us/dep/rpp/rms/agreedown/urwater.pdf
South Jersey Guide: https://www.nj.gov/dep/rpp/rms/agreedown/radwater.pdf
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•Inorganic arsenic – naturally occurring 

or anthropogenic

•Very prevalent in NJ Piedmont Province

• Pyrite found in black shale

•Hematite and clay minerals from red 

shale

• Potential chronic drinking water 

exposure effects: variety of cancers 

(skin, lung, urinary bladder, etc.), 

diabetes

• Exposure routes: ingestion and dermal

• Odorless, colorless, tasteless in 

drinking water

•Only way to detect arsenic – test 

your water!

Arsenic Background Information

Serfes M 2004, Black and red shale beds 

in Passaic Formation

https://www.nj.gov/dep/njgs/enviroed/infocirc/arsenic.pdf
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NJ Arsenic Standard

• Current federal standard: 10 µg/L

• Current NJ arsenic standard: 5 µg/L
• Both became effective in January 2006

• New Jersey and New Hampshire - most protective 

standard

• Prior, standard was 50 µg/L

• Maximum contaminant level goal (MCLG) of 0 µg/L
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Common complications/issues 
with arsenic removal

• Two inorganic species: As III (arsenite) and As V (arsenate)

• Different species – limited testing availability from commercial 
labs

• Arsenic speciation cartridges

• Typical water treatment (water softener or anion exchange) will 
NOT remove As III from drinking water

• Possible indicators of presence of As III:

• dissolved iron (> 100 µg/L)

• manganese (> 50 µg/L)

• sulfur odor

• pH can negatively impact water treatment

• Two-tank arsenic treatment system recommended in NJ
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Recommended Arsenic Water 

Treatment

Raw 
Water

Treated
Water

Arsenic 
Worker 

Tank

Arsenic 
Safety 
Tank

34



Arsenic 

Worker 
Tank

Arsenic
Safety

Tank

Pre 

Sediment 

Filter
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Treatment
Type

Preferred
Treatment

Process / 
Maintenance

Chemical 
Use

Waste 
Generated

Arsenic 
Species 

Removed

Typical 
Media 

Life

Average 
Installation 

Cost

Whole-
House 

Adsorption

1st Choice Simple None Low As3 & As5 2-3 years $2,495

Point-of-Use 
Adsorption

2nd 
Choice

Simple None Low As3 & As5 2-3 years $835/Unit

Whole-House
Anion 

Exchange

No Complex Salt High As5 
Only

10 years $2,000

Point-of-Use  
Reverse 
Osmosis

No Moderate Disinfectant Low As5 Only 3 years $835/Unit

Arsenic Water Treatment Options
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http://njarsenic.superfund.ciesin.columbia.edu/

Website Features:

• Key facts regarding arsenic 

exposure

• Health Risks

• Informative videos

• Testing and treatment 

options

Additional Resources:

• Detailed arsenic treatment 

presentation: 

https://www.youtube.com/watc

h?v=xH8v2mZeVYQ

Arsenic Awareness Website
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Water Treatment Financing Programs
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Water Treatment Financing: 
New Jersey Housing and Mortgage Finance 

Agency (NJHMFA)

https://www.state.nj.us/dca/hmfa/consumers/homeowners/

• Eligibility:

• Individual private well 

homeowners only

• Violations of state Primary 

Drinking Water Standards

• Some secondary Drinking 

Water Standards included

• Maximum loan amount: 

$10,000:

• 0% no-interest

• 10-year maximum term

• Potable Water Fact Sheet:

https://www.state.nj.us/dca/h

mfa/consumers/docs/ho_pota
blewater_fs.pdf
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Water Treatment Financing: 
NJ Spill Compensation Fund

• Compensation for damage caused by discharge of hazardous substances 
(manmade chemicals)

• Qualifications:

• Requires certified laboratory test: initial and confirming

• Eligible claim applicable if initial and confirmation results exceed drinking 
water standards

• More complicated damages must include evidence/documentation

• Claims may be eligible for:
• Installation of water treatment

• Confirmation test fee

• Connection to public waterline

• Contact Environmental Claims Administration (ECA) to file a claim

• URL for claim forms: https://www.nj.gov/dep/srp/finance/ecaclaim.htm

• Claims must be filed within one year from date of damage discovery

https://www.nj.gov/dep/srp/finance/spillfund/spillfund_faqs.htm 40
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Public Notification: 

Neighbor Outreach
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NJ PWTA Public Notification

• Local health department is

“authorized to issue a public notice to owners of property within 
vicinity of the subject property suggesting or recommending 
that property owners may wish to have nearby wells sampled 
for the failed parameter(s)”

• The specific address or location of the failed private well shall 
not be identified

• Notification shall be made at a minimum of 200ft

• Public notification at sole discretion of local health authority
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Does your department conduct any neighbors 
outreach?

ⓘ Start presenting to display the poll results on this slide.



Demonstration Example #1: 
Statewide PWTA Neighbors Arsenic 
Outreach

• Targeted PWTA arsenic neighbors

• Distance: < 500 ft., 500 – 1,000 ft.

• Invitation letters sent to 1,743 private well homeowners

• Free arsenic test kit mailed to participants (n=274)

• Wells tested: n=214

• 70% of wells previously untested
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Arsenic 
Results by 
Distance

All

Wells

Within 500 

ft.

500 – 1,000 

ft.

# of raw samples

214 151 60

Max. Arsenic 

Level (µg/L) 66.0 66.0 14.4

% Exceeding 

MCL

(> 5 µg/L)
26.2%

(n=56)

33.8% 

(n=51)

8.3%

(n=5)

Flanagan, S., et al. (2020) Summary of arsenic results by distance to neighbor's well

Arsenic Results –
Distance from Neighbors Well
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Risk Communication Language

• Three risk version outreach letters sent out, “A well in your 
neighborhood with arsenic at levels: 

• Low (5 – 10 µg/L): above the standard..." 

• Medium (10 – 25 µg/L): several times higher than..."

• High (> 25 µg/L): 5 times higher than..." 

• Homeowners receiving high risk letters

• More likely to request arsenic test kit compared to low-risk 
letters (17.4% vs. 12.8%)

• And higher participation (14.9% vs. 10.5%)
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Legend

Demonstration Example #2: 
Gross Alpha PWTA Neighbors

• Targeted neighbors of high PWTA (> 100 
pCi/L) gross alpha homes within 500 
foot-distance

• 412 neighbors identified and 5 high 
gross alpha wells confirmed

• Free testing for 75 wells

• Contaminants tested:

• Raw water - gross alpha (map), 
radium, uranium, radon, iron

• Treated water – gross alpha

47
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Number & Percentage of Neighboring Wells 

Exceeding the Standard

Gross Alpha

(> 15 pCi/L)

Iron

(> 300 µg/L)
Radium

(> 5 pCi/L)

Radon

(> 800 pCi/L)

All 52 (69%) 13 (17%) 43 (59%) 20 (27%)

North 12 (55%) 1 (5%) 3 (14%) 19 (86%)

South 40 (76%) 12 (23%) 40 (78%) 1 (2%)

Raw Water Results:
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Gross Alpha Neighbors –
Drinking Water Exposure
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Tested
n = 75

Pass

n = 56
(< 15 pCi/L)

Fail

n = 19
(> 15 pCi/L)

Treatment

n = 49

No 

Treatment

n = 7

Treatment

n = 13

No 

Treatment

n = 6



Neighbors Outreach –
Summary

• Lack of awareness of widespread arsenic and gross 
alpha occurrence in local regions

• Outreach to neighbors is effective at identifying 
contaminated wells

• Recommend outreach to neighbors within 500 ft
• Percentage of high exceeding wells increases with proximity

• Highest exceeding neighbor wells > 200ft

• Appropriate high-risk messaging improves participation

• Discrepancies among high PWTA gross alpha value, 
confirming high PWTA wells prior to selecting neighbors 
may be useful.
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Identification of 

Neighbors:

Tips & Tools
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Does your department use mapping software?

ⓘ Start presenting to display the poll results on this slide.



Identification of High-Risk Neighbors

• PWTA data to identify high exceeding wells

• NJDEP -> County Health Department

• If you are not getting the data you can reach out to  
Richard.Gunosky@dep.nj.gov

• Geographic Information Systems (GIS) ArcMap

• Software program used for spatial and geographic 
data analysis

• Map
• Wells may have incorrect X,Y values – check these 

first

• Select neighbors within buffer radius of choice (e.g., 
200, 500, 1000ft)
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Removing specific properties

• Parcel data includes mailing addresses, property location 
(sometimes can be different from street address) – does the 
person really live here?

• Specific properties removed prior to selecting neighboring homes 
for outreach

• Churches, farms, schools, etc.

• Double check building descriptions (BLDG_DES) to check whether 
they're a house or not

• Low property values (e.g. - below $1,000)

• Addresses with a P.O. box address

• Zip codes from other states

• May need to remove duplicate addresses
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Buffers surrounding Neighbor Parcel 
Data (Highlighted in Green)
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Notification Letters Sent Out

• Letters addressed to 

resident name of 

neighboring homes

• Dear "Resident Name or 

Current Resident"

• Current resident also 

addressed

• New homeowner could 

be residing in home

• Free water test 

opportunity outlined in 
letters

• Registration link 

also outlined in letters

Resident Name

Address
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Please complete a brief survey – we will use your response as 
attendance record for Public CE credits.

Link to survey: http://healthsurveys.nj.gov/NoviSurvey/n/zz2km.aspx

Special thanks to Dr. Steve Spayd, Dr. Nick Procopio, Heidi 
O’Neill and Dr. Sara Flanagan

For questions about anything discussed today contact jessie.gleason@doh.nj.gov
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Step by Step GIS Instructions 
for Neighbor Identification
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https://njgin.nj.gov/njgin/edata/imagery/index.html#!/

Upload New Jersey 

Imagery

• Enter NJ Geographic Information 
Network → Imagery

• Under "Streaming", find desired 
imagery map and click on 
"ArcGIS REST"

• Open in ArcGIS Desktop
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Upload New Jersey Parcel 

Data

• Click on "Parcel Data" in NJ 
Geographic Information 
Network

• Under "Downloads" click 
"Statewide Parcels Joined with 
MOD-IV Download"

• Place data in appropriate folder 
and extract data ("Extract All...")

https://njgin.nj.gov/njgin/edata/parcels/index.html#!/ 60
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Upload New Jersey Parcel 

Data

• In ArcMap, click File → Add 
Data → Add Data...

• Add Parcels_MOD4_Statewide.gdb
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2015 Imagery Map

Parcel Data
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GIS: Inserting "Corrected" X & Y Data
• Add Excel Spreadsheet only with PWTA 

exceedances
• Data contains X and Y coordinates
** Make sure Excel spreadsheet saved 
as Comma Delimited (*.csv)

Projected Coordinate System: 
NAD_1983_StatePlane_New_Jersey_FIPS_2900_feet
Geographic Coordinate System: GCS_North American_1983
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GIS: To create a buffer...
• Go to ArcToolBox

• Analysis Tools → Proximity → Buffer
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GIS: To create a buffer...

•Identify input feature (PWTA point buffer will surround)

•Output Feature Class: 

•Folder location

•Saved as a shapefile (.shp)

•Identify the buffer of choice (250, 500, etc…)

•Select Unit (e.g. feet)
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• Buffer intersects the parcel

• How to obtain neighbor identification 

with certain proximity

GIS: Intersecting buffer to parcel 
data
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Buffers surrounding high contaminant 
wells

High contaminant well location

Buffers
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Export Data
• Right click buffer intersect shapefile and 

click "Open Attribute Table"

• In left hand corner, click export and save 

table as a excel file
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Neighbor's block and lot data (Buffer Intersect)
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Removing specific properties

• Parcel data includes mailing addresses, property location 
(sometimes can be different from street address) – does the 
person really live here?

• Specific properties removed prior to selecting neighboring homes 
for outreach

• Churches, farms, schools, etc.

• Double check building descriptions (BLDG_DES) to check whether 
they're a house or not

• Low property values (e.g. - below $1,000)

• Addresses with a P.O. box address

• Zip codes from other states

• May need to remove duplicate addresses
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• ArcToolBox → Conversion Tools → Geodatabase → Table to Table 
Join

• Table to Table join – Neighboring worst wells with PAMS PIN

Table to Table Join
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Buffers surrounding Neighbor Parcel 
Data (Highlighted in Green)
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GIS Results

• Use identify tool to click on parcel and 

find address associated with parcel

• Neighbor parcels highlighted

• Selected neighbors and their 

addresses entered into Excel 

spreadsheet
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